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Preface
he IBM Asset Transformation Workbench (ATW) is a suite of 
PC-based software products for analyzing, re-architecting, and 
transforming legacy applications. The products are deployed in 

an integrated environment with access to a common repository of pro-
gram objects. Repository models serve as the basis for a rich set of dia-
grams, reports, and other documentation.

The ATW suite consists of customizable modules that together address 
the needs of organizations at every stage of legacy application evolution 
— maintenance/enhancement, renovation, and modernization. 

Audience

This guide assumes that you are a corporate Information Technology 
(IT) professional with a working knowledge of the legacy platforms you 
are using the product to analyze. If you are transforming a legacy appli-
cation, you should also have a working knowledge of the target platform.

T
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Organization

This guide contains the following chapters:

• Chapter 1, “Introducing the Asset Transformation Workbench,” de-
scribes the ATW tools, process, basic concepts, and supported lega-
cy languages. 

• Chapter 2, “Installing and Configuring ATW,” describes hardware 
and software requirements for ATW, and how to install and config-
ure the workbench. 

• Chapter 3, “Asset Transformation Workbench Basics,” describes 
how to start ATW, create workspaces and projects, add files to a 
workspace, use workbench windows, and set workbench options. 

• Appendix A, “Installing and Using the WSAA Bridge,” describes 
how to install the WSAA bridge and how to use it to distribute the 
source files in a WSAA project to PCs running ATW.

• The Glossary defines the names, acronyms, and special terminology 
used in this guide.

Conventions

This guide uses the following typographic conventions:

• Bold type — Indicates a specific area within the graphical user in-
terface, such as a button on a screen, a window name, or a command 
or function.

• Italic type — Indicates a new term. Also indicates a document title. 
Occasionally, italic type is used for emphasis.

• Monospace type — Indicates computer programming code.

• Bold monospace type — Indicates input you type on the com-
puter keyboard.

• 1A/1B, 2A/2B — In task descriptions, indicates mutually exclusive 
steps: perform step A or step B, but not both.
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Related Manuals

This document is part of a complete set of ATW manuals. Together they 
provide all the information you need to get the most out of the system. 

• Preparing Projects describes how to set up ATW projects. This 
guide describes how to load applications in the repository and how 
to use reports and other tools to ensure that the entire application is 
available for analysis.

• Analyzing Projects describes how to analyze applications at the 
project level. This guide describes how to create diagrams of appli-
cations and how to perform impact analysis across applications. It 
also describes how to estimate project complexity and effort, and 
how to create a project dictionary.

• Analyzing Programs describes how to analyze applications at the 
program level. This guide describes how to use HyperView tools to 
view programs interactively and perform program analysis in stages. 
It also describes how to analyze procedure and data flows, search the 
repository, and extract business rules with HyperView.

• Profiling Projects describes how to create and browse Web-generat-
ed views of the repositories in your organization. 

• Creating Components describes how to extract program components 
from a legacy application.

• Parser Reference Manual describes legacy constructions supported 
by Application Analyzer in reference format.

• Architecture Reference Manual describes legacy constructions sup-
ported by Application Architect in reference format.
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Online Help

In addition to the manuals provided with the system, you can learn about 
the product using the integrated online help. All GUI-based tools include 
a standard Windows Help menu. 

You can display:

• The entire help system, with table of contents, index, and search 
tool, by selecting Help:Help Topics.

• Help about a particular ATW window by clicking the window and 
pressing the F1 key.

Many ATW tools have guides that you can use to get started quickly in 
the tool. The guides are help-like systems with hyperlinks that you can 
use to access functions otherwise available only in menus and other pro-
gram controls. 

To open the guide for a tool, choose Guide from the View menu. Use the 
table of contents in the Page drop-down to navigate quickly to a topic.
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Introducing the Asset 
Transformation Workbench
he IBM Asset Transformation Workbench (ATW) is a suite of 
PC-based software products for analyzing, re-architecting, and 
transforming legacy applications (Figure 1-1). The products are 

deployed in an integrated environment with access to a common reposi-
tory of program objects. Repository models serve as the basis for a rich 
set of diagrams, reports, and other documentation.

Figure 1-1 Asset Transformation Workbench (ATW) 

T
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ATW Products

The ATW suite consists of customizable modules that together address 
the needs of organizations at every stage of legacy application evolution 
— maintenance/enhancement, renovation, and modernization. Each 
module is separately licensed. 

Application Analyzer

Application Analyzer is a robust set of non-invasive interactive tools that 
work with source code, system files, DDL, screen maps, and more. Use 
it for analyzing and documenting legacy systems at both the application 
and program levels. 

Use Application Analyzer at the application level to:

• Create diagrams of applications.

• Perform impact analysis across applications.

• Estimate application complexity and effort.

Use Application Analyzer at the program level to:

• View programs interactively.

• Perform program analysis in stages. 

• Perform impact analysis on a program.

• Model and search the repository.

Application Profiler

Application Profiler provides a set of views, or profiles, of the applica-
tion, based on the object models created in the previous analysis phase.

• WebGen generates HTML views of the repositories on your work-
station. You can publish the views to Profiler, where they can be 
accessed by any member of your organization with a browser. 

• Profiler is a Web server-based tool that offers company-wide access 
to any repository in your organization. It gives managers, business 
analysts, testers, and customer support personnel convenient, brows-
er-based access to analyzed legacy code.
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Application Architect

Application Architect uses advanced algorithms to partition code into 
new components and perform Dead Code Elimination. 

• Structure-based componentization modularizes legacy programs by 
replacing a range of inline code with a call to a reusable component. 
Application Architect examines the dependencies that are required 
to make the callable routine complete. 

• Computation-based componentization creates a functionally com-
plete program that contains all the logic necessary to calculate the 
value of a particular variable — ensuring consistency and improving 
maintainability by providing reusable routines for calculations that 
might be needed in different parts of the application.

• Domain-based componentization creates a new specialized program 
based on the values of one or more variables. A program that reads 
a file of payments and invokes specialized processing based on a 
“payment type” variable held on each input record, for example, 
could be specialized on the value of PAYMENT-TYPE = "CHECK". 
A functionally complete program would be created to process only 
CHECK payments. 

Business Rule Manager

Business rules encapsulate your application’s business logic, making the 
application easier to understand, document, maintain, and test. And if 
you decide to modernize the application, they help ensure that all of its 
business logic gets implemented. 

A business rule is a named container that identifies and documents code 
segments according to their business function. A business rule named 
Calculate Date Difference, for example, might consist of this segment:

COMPUTE WS-DATE-VARIANCE = 
WS-C-CARD-DATE-CCYYMM - WS-TODAYS-DATE-CCYYMM. 

Business Rule Manager lets you generate business rules from code 
segments extracted manually from source or autodetected. Automated 
documentation and a complete set of reports make it easy to develop the 
kind of detailed specification you’ll need before redeveloping a legacy 
application in a modern programming language. 
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ATW Process

Figure 1-2 shows the ATW process. Each stage in the process has a cor-
responding menu in the ATW window. (Of course, you will only see a 
menu if you have purchased the product it gives access to.) Let’s take a 
brief look at each of the stages.

Figure 1-2  ATW Process

Prepare

Before you can analyze a legacy application, you need to prepare it. Pre-
paring an application consists of loading, or registering, the application 
in the repository, and then verifying that the entire application can be un-
derstood by the ATW parser. You use reports and other tools to ensure 
that your application can be parsed in its entirety.

Architect Extract

Analyze

Profile

Prepare

Relaxed Parsing

The relaxed parsing option lets you verify a source file despite errors. 
Ordinarily, the parser stops at a statement when it encounters an error. 
Relaxed parsing tells the parser to continue to the next statement. 

The database the relaxed parser generates lets you resolve undefined 
variables in missing copybooks and identify incorrect or unsupported 
statements. Once you have fixed these problems, you should be able 
to verify the file with the regular parser.
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Analyze

Application analysis is the basis for all of the remaining stages in the pro-
cess. You analyze legacy systems at the application or program level. 

• Use the application analysis tools to create diagrams of applications 
and perform impact analysis across applications. Other application 
analysis tools let you estimate project complexity and effort, and 
create application dictionaries.

• Use the program analysis tools — collectively called HyperView — 
to view programs interactively and perform program analysis in 
stages. You can also use HyperView to analyze procedure and data 
flows, extract business rules, and create logical components.

Profile

Profiles are HTML views into a repository that show all of the analysis 
you have done on an application. Profiles are convenient ways to share 
information about legacy applications across your organization.

Architect

A structured architecture reduces complexity and eases modernization. 
In this stage, you partition a legacy application into new components. It’s 
a good idea to perform some re-architecting activity — dead code elim-
ination, for example — before undertaking transformation.

Extract

Business rule extraction distills business logic from complex code for 
documentation, gap analysis, application redevelopment, test planning, 
and other management tasks.

More On HyperView

HyperView tools are available within the application analysis tools as 
well, but “silently” — that is, without your ever actually invoking 
them as HyperView tools.
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Repositories, Entities, and Relationships

The repository on your machine contains the model of your legacy appli-
cation created by the ATW tools. A repository is a database of model ob-
jects, or entities. 

The relationships between entities describe the ways in which the 
elements of your application interact. In Figure 1-3, the source file 
GSS.CBL defines the GSS program. The program, in turn, reads the 
data file GSS.FCSTSEC.

Figure 1-3 Entities and Relationships

Workspaces and Projects

A workspace is a named container for an application or a portion of an 
application. You can divide a workspace up into projects that represent 
different parts of the application (Figure 1-4). You might have a project 
for the batch portion of your application and another project for the on-
line portion, for example. You can also use a project to collect items for 
discrete tasks — all the source files affected by a change request, for ex-
ample.

Figure 1-4 Repositories, Workspaces, and Projects

relationships

Repository

Project

Workspace

Project
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When you create a workspace in ATW, the system creates a repository 
for the workspace and a default project with the same name as the work-
space. You can create new projects and move or copy entities between 
projects as needed.

Supported Legacy Languages

ATW tools work with legacy applications written in Cobol, PL/I, Natu-
ral, and other programming languages. Your license determines which 
languages your installation supports. For detailed information on sup-
ported languages, dialects, and versions, see the ATW Release Notes.

What’s Next?

Those are all of the basic concepts underlying the ATW scheme. Now 
let’s look at how you install the workbench and get it running.
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2
Installing and Configuring ATW 
his chapter describes how to install and configure ATW. It lists 
the minimum hardware and software requirements for ATW in-
stallations and describes the contents of the installation CD. It 

then shows you how to run the installation and configure the workbench 
for the programming languages, legacy dialects, character sets, and tools 
in use at your site.

Check Read Me File

Be sure to check the ATW Read Me file for late-breaking information 
that may affect the successful installation of the software. You can 
find the Read Me on the installation CD. You can also view the Read 
Me after installation by clicking Programs:IBM:ATW Documenta-
tion:Read Me in the Windows Start menu.

T
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Hardware and Software Requirements

Table 2-1 lists the hardware, disk space, operating system, and software 
requirements for ATW installations. Hardware requirements may vary 
depending on the size of the application you are analyzing. 

Contents of Installation CD

ATW software ships on a single CD. The CD autoruns the ATW instal-
lation program. 

Note: Make sure the autorun feature is active for your CD drive. 
Check your operating system documentation for information 
on the autorun feature.

Table 2-1 Hardware and Software Requirements

Intel-compatible PC

Operating System Windows 2000 (U.S. English), with 
MS Service Pack 4+
Windows XP (U.S. English), with 
MS Service Pack 1
Windows 2000 (Japanese), with MS 
Service Pack 4+

Web Browser Internet Explorer 5.01 or higher

Processor/CPU 2 GHz or higher

Memory 1 GB minimum
2 GB recommended
1 GB to 3 GB swap space 

Disk Space for Workbench 200 MB 

Disk Space for Application Files 30x size of original source 
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Running the Installation Program

Before running the installation program, make sure you have administra-
tive permissions for the machine on which you are installing the work-
bench. If you do not have administrative permissions, the installation 
program will not let you continue.

To install ATW:

1 Insert the CD into your CD-ROM drive. The CD autoruns, and 
the Welcome screen opens (Figure 2-1). If autorun does not start, 
double-click the setup.exe program in the CD installation folder.

Figure 2-1 Welcome Screen

2 Click Next to continue. The License Agreement screen opens 
(Figure 2-2 on page 2-4).
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Figure 2-2 License Agreement Screen

3 Read the License Agreement carefully. Click I accept the terms 
in the license agreement to accept its terms, then click Next to 
continue. 

4 The Customer Information screen opens (Figure 2-3).

Figure 2-3 Customer Information Screen
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5 The User Name and Organization fields are prefilled with your 
user name and company. These fields determine the user name 
and company that appear on your license. Modify the entries if 
necessary. Click Next to continue. The Destination Folder screen 
opens (Figure 2-4).

Figure 2-4 Destination Folder Screen

6 Choose an installation folder for ATW. Figure 2-4 shows the screen 
prefilled with the default C:\Program Files\Asset Trans-
formation Workbench. To accept the prefilled value, click Next.

To specify a different folder, click Change. The Change Current 
Destination Folder screen opens (Figure 2-5 on page 2-6).
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Figure 2-5 Change Current Destination Folder Screen

CAUTION: It is strongly recommended that you not install the workbench in 
a folder with a name that contains escape control characters.

Navigate the folder structure to find a suitable location. Edit the path 
if necessary. If the destination folder does not exist, the installation 
creates it. Click OK to exit the Change Current Destination Folder 
screen and return to the Destination Folder screen. Click Next in the 
Destination Folder screen to continue. The Ready to Install the Pro-
gram screen opens (Figure 2-6 on page 2-7).
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Figure 2-6 Ready to Install the Program Screen

7 Click Install to begin transferring files to your PC. A progress meter 
indicates the progress of the transfer.

Note: To make changes to the settings, click Back repeatedly until 
you find the information you are looking for, make your 
changes, then click Next until you return to the Ready to In-
stall the Program screen.

8 When the transfer is complete, the Setup Complete screen opens 
(Figure 2-7 on page 2-8).
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Figure 2-7 Setup Complete Screen

9 Click Finish. The ATW Configuration Manager opens. Follow the 
steps in “Configuring ATW” on page 2-9.
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Configuring ATW

Use the Configuration Manager in the ATW Administration tool to con-
figure your workbench for the products, tools, programming languages, 
dialects, and character sets in use at your site. 

If you configure your workbench for Cobol, for example, you will see 
only the workbench options and displays appropriate for Cobol modern-
ization. If it turns out that you need to configure your workbench for PL/I 
as well, you can always come back to the Configuration Manager and se-
lect PL/I in addition to Cobol.

To configure ATW:

1A If you are installing ATW, click Finish in the Setup Complete screen 
(Figure 2-7 on page 2-8). The Configuration Manager window 
opens (Figure 2-8 on page 2-10). 

1B If you have previously installed ATW and want to reconfigure it, 
choose IBM, then Asset Transformation Workbench Adminis-
tration in the Programs folder on the Windows Start menu. The 
Administration tool opens. In the Administer menu, choose Con-
figure Workbench.

You are prompted to exit ATW. Click OK, then close ATW if nec-
essary. The Configuration Manager window opens (Figure 2-8 on 
page 2-10).

2 Select each workbench product, programming language, dialect, and 
character set currently in use at your site. The core Application An-
alyzer product is always selected. Select Additional Tools to enable 
tools not used in typical workbench configurations.

3 Click OK. You are notified that the Configuration Manager has set 
up your configuration packages successfully. Click OK to return to 
the Administration tool window.
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Figure 2-8 ATW Configuration Manager Window

Migrating Workspaces

If you have created workspaces in a previous release of ATW, the system 
prompts you to upgrade the workspaces to the new release — migrate 
the workspaces — when you open them for the first time. You must re-
verify a workspace after migrating it.

What’s Next?

You have successfully installed and configured ATW on your PC. Now 
let’s start the workbench and take a quick tour of basic workbench fea-
tures. 
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Asset Transformation 
Workbench Basics
ow that you have installed Asset Transformation Workbench, 
you are ready to start using the workbench tools to analyze leg-
acy applications. This chapter looks at some elementary ATW 

tasks: how to start the workbench, create a workspace and project, use 
workbench windows, set options, and export system diagrams and re-
ports. 

Starting ATW

When you start ATW for the first time after installing it on your PC, you 
are prompted to create a new workspace or open an existing workspace. 
A workspace is a named container for an application or portion of an 
application. The projects in a workspace represent different parts of the 

Copy Legacy Files to an Accessible Location

Before registering your legacy application in ATW, make sure you 
have copied legacy files to a location accessible to your PC. 

N
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application. When you create a workspace in ATW, the system creates a 
default project with the same name as the workspace.

Note: The following section describes a streamlined procedure 
for creating a workspace that is appropriate for most installa-
tions. You can find detailed information on workspace setup 
in Preparing Projects. For information on startup options, see 
“To set workbench startup options:” on page 3-24.

To start ATW:

1 In the Windows Start menu, go to the Programs folder. Choose 
IBM, then Asset Transformation Workbench. The Create new 
workspace dialog opens above the main ATW window (Figure 3-1).

Figure 3-1 Create New Workspace Dialog
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2 To create a new workspace, double-click the New icon or select it 
and click OK. The New Workspace dialog opens (Figure 3-2).

Figure 3-2 New Workspace Dialog

3 In the Save in drop-down, choose the folder to save the new work-
space in. In the File name field, enter the name of the new work-
space. Choose a name that describes the legacy application as 
closely as possible. Click Save. The Add Files to Workspace dialog 
opens (Figure 3-3).

Figure 3-3 Add Files to Workspace Dialog

4 In the Look in drop-down, choose the folder that contains the legacy 
application files to add to the workspace. In the list of files in the 
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center of the dialog, choose the files you want to add to the work-
space. You can restrict the list of files to a certain type by choosing 
the type in the Files of type drop-down.

Tip: To add a range of listed files to the workspace, hold down the 
Shift key, click the first item in the range, then click the last 
item in the range. To add selected files, hold down the Control 
key, then click each file you want to add. 

5 Click Open to add the files to the workspace. You are notified that 
you have registered the files successfully and are prompted to verify 
the files (Figure 3-4).

Figure 3-4 Success Dialog

6 Select Verify the above files in the dialog and click OK. The system 
verifies the files. When verification is complete, the ATW window 
is populated with the verification results (Figure 3-5 on page 3-5).

What File Outputs Can You Expect?

Now look in the destination folder you specified in step 3 on page 3-3. 
There you will see that the system created a workspace file and a fold-
er with the same name. 

The workspace file has a .rwp extension. You can double-click the 
icon for the file to open it in the workbench. The \Workspace\Sources 
subfolder contains copies of the legacy application files you added to 
the workspace, organized by file type. 
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Using the ATW Main Window

The ATW main window lets you view and edit projects, set workbench 
options, and open workbench tools. The window’s state — size, loca-
tion, menu selections, and option settings — is saved across sessions. 
Menu selections for the panes in the window are available only if the 
pane has the focus.

Figure 3-5 shows the ATW main window in a typical configuration. This 
section takes a closer look at the items labeled in the figure.

Tip: Most workbench menu choices have equivalent choices in the 
right-click menu or equivalent option settings (see “Setting 
Options” on page 3-24).

Figure 3-5  ATW Main Window

tool tip

Repository Browser

Editor

Object Information

Activity Log

menus and tool 
bars
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Menus

ATW menus let you access workbench tools and other workbench func-
tionality. Menus are displayed only for the products you have enabled 
(see “Configuring ATW” on page 2-9). Table 3-1 shows the relationship 
between menus and products. 

Note: The screens shown in the ATW document set display the 
menu bar with all products installed.

Customizing Menus

ATW-specific menus are fully customizable. You control which menus, 
choices, and tool bars the system displays. You can save a menu bar con-
figuration and restore it with a single mouse click. 

Note: You cannot customize the Windows standard menus — File, 
Edit, View, and so forth.

To customize ATW menus:

1 In the Tools menu, choose Customize Menu. You are prompted to 
close the Editor pane. Click OK. The Customize Menu window 
opens (Figure 3-6 on page 3-7).

2 In the Customize Menu window, deselect the menus and/or menu 
choices you want to hide. Select the menus and/or choices you want 
to show.

Table 3-1 Products and Menus

Product Menu

Application Analyzer Analyze

Application Profiler Profile

Application Architect Architect

Business Rule Manager Extract



Asset Transformation Workbench Basics
Using the ATW Main Window

3-7
3 Enter a name for the specified menu configuration in the drop-down 
list below the Load button. 

4A Click Save if you want to save the configuration without dismissing 
the window. 

4B Click OK if you want to save the configuration and dismiss the win-
dow. The new configuration is applied in the ATW main window. 

Note: To restore a menu configuration, select its name in the drop-
down list and click Load. To restore the default configuration, 
select (default) in the drop-down list and click Load.

Figure 3-6 Customize Menu Window
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Tool Bars

You can also access an ATW menu function by clicking its tool bar icon. 
The tool tip for an icon tells you what it does. Place your cursor over the 
icon for a moment. The tool tip will display. 

The workbench has tool bars for the File, Edit, and Project menus, as 
well as the menus listed in Table 3-1 on page 3-6. A tool bar is displayed 
only if its corresponding menu is displayed (see “Customizing Menus” 
on page 3-6). You can change the position of a tool bar by grabbing the 
delimiter at the left of the tool bar and dragging it to a new location 
(Figure 3-7).

Figure 3-7 Changing the Position of a Tool Bar

Repository Pane

The Repository pane displays the contents of the current workspace. 
Double-click a file to display its source code in the Editor. Place your 
cursor over an object for a moment to display a tool tip that describes the 
object in more detail.

Unverified and Verified Workspaces

If you have not verified a workspace file, the file is displayed in bold 
type. Since the system has not generated an object model of the file’s 
contents, only the file itself is displayed.

A verified file shows all the objects in the model generated for the file. 
Verification results are denoted as follows:

• A blue dot means that the parser has verified the file successfully. 

• A red dot means that the parser has encountered an error in the 
file.

• A yellow dot means that the parser has encountered an error in the 
file, but the relaxed parser has verified the file successfully.

click and drag
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Figure 3-8 compares unverified and verified workspaces. Notice in 
the verified workspace that the parser has built an object model for Day-
OfWeek.cbl, but not for DayOfWk.cbl, which contained an error. Gen-
erally, the parser creates an object model for as much of the file as it 
understands.

Figure 3-8 Unverified and Verified Workspaces

Browser View

The browser view of the Repository pane displays workspace objects 
in hierarchical form, organized by project and object type (Figure 3-9 on 
page 3-10). Click the Browser choice in the View menu to show the 
browser view. 

Click the plus sign (+) next to an object to expand its hierarchy. Click the 
minus sign (-) to collapse the hierarchy. You can export a subtree to a text 
file by right-clicking it and choosing Save Subtree in the pop-up menu.

Tip: The drop-down on the Project tool bar displays the current 
project. You can navigate quickly to another project in the 
browser view by clicking the project name in the drop-down. 

Select (none) in the drop-down to make the entire work-
space current. For more information, see “Project Contents 
and Workspace Contents” on page 3-11). 

unverified

verified
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Figure 3-9 Browser View

Search View

The search view of the Repository pane displays an alphabetical list of 
workspace files returned by a search of the repository (Figure 3-10 on 
page 3-11). Click the Search choice in the View menu to show the view. 

The search is performed on the current project or, if there is no current 
project, on the entire workspace. To restrict the list of files to a given file 
type, select the file type in the drop-down above the search view. 

Click the  button to perform the search. You can export a list to a text 
file by right-clicking it and choosing Save List in the pop-up menu.

By default, the list shows two attributes of an object: its name and file 
type. Click the attribute column heading to sort the list by that attribute. 
You can select additional attributes to display in the Workspace Options 
window. Choose Workspace Options in the Tools menu. In the General 
tab, select the attributes in the Display Attributes pane. 

Note: Only attributes of the selected object are displayed. That is, if 
you choose the Cyclomatic Complexity attribute while a JCL 
file is selected, the attribute will not be displayed, because 
Cyclomatic Complexity is not an attribute of a JCL file. 

relationships

double-click to 
view source
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Figure 3-10 Search View

Hiding a Browser View or Search View

You can hide a browser view or search view by right-clicking it and 
choosing Hide in the pop-up menu. To restore the view, choose Browser 
or Search as appropriate in the View menu. 

Tip: Occasionally, you may be able to improve performance — of 
a repository refresh, for example — by hiding the browser.

Project Contents and Workspace Contents

By default, the system displays the contents of the workspace organized 
by project. You can display the contents of the entire workspace — that 
is, all the objects in the workspace, regardless of the project they are in 
— by choosing Entire Workspace in the View menu.

Tip: The workspace tree contains folders for object types that are 
not separately listed in project views. These can be useful 
when you are trying to locate all objects of a certain type.

Selecting Objects in the Repository Pane

You select an object in the Repository pane by clicking it. To select 
all the objects in the search view or all the objects under the selected 
workspace, project, or folder in the browser view, choose Select All in 
the Edit menu. To deselect objects, choose Unselect All in the Edit 
menu.

double-click to 
view source

restrict by file 
type

click to search
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To select a range of objects, hold down the Shift key, click the first object 
in the range, then click the last object in the range. To select objects that 
are not in a range, hold down the Control key, then click each object you 
want to select.

Use the Select choices in the Edit menu to select objects based on their 
verification status. The choices operate on the entire list in the search 
view and on the objects under the selected workspace, project, or folder 
in the browser view.

Searching for Objects in the Repository Pane

You can use predefined filters for object searches in the Repository pane, 
or create your own. You can filter on object type, name, verification sta-
tus, and matching text. You can replace text if necessary. 

To create a search filter:

1 In the Edit menu, choose New Criteria. The Search dialog opens 
(Figure 3-11).

Figure 3-11 Search Dialog

filter on name

filter on entity 
type

filter on verification 
status

filter on matching 
text
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2 To filter on entity type, select the Entity Type check box and choose 
the entity type in the accompanying pane.

3 To filter on object name, select the Object Name Like check box 
and enter the text for the name match in the accompanying field. 
You can use wildcard patterns allowed in LIKE statements by Visu-
al Basic for Applications (VBA). 

4 To filter on verification status, select the Where Parse Status check 
box and choose the status in the accompanying group box.

5 To filter on a text match, select the Scan Legacy Sources For check 
box and enter the pattern for the match in the accompanying drop-
down. You can enter plain character strings, regular expressions, or 
wildcards. Click the radio button for the type of pattern matching 
you want to use.

For regular expressions and wildcards, click the right arrow button 
next to the drop-down to display a list of elements you can insert in 
the pattern. You can use Posix regular expressions and wildcard pat-
terns allowed in LIKE statements by Visual Basic for Applications 
(VBA).

Select the check boxes below the drop-down if you want the search 
to match case, skip comments, and/or match whole lines.

6 In the Filter Name drop-down, enter the name of the search filter 
and click Save. 

Tip: Every search filter you create is saved, whether or not you 
save it explicitly. To delete a search filter, select it in the Fil-
ter Name drop-down and click Delete. To clear a search fil-
ter, select it in the Filter Name drop-down and click Clear. 

To execute a search filter:

1 In the Search dialog (Figure 3-11 on page 3-12), choose the filter 
you want to execute in the Filter Name drop-down. You can choose 
a predefined or user-defined filter.

2 Click Find. The list of objects is returned in the search view.
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To replace matched text:

1 In the search view, select the objects you want to search and choose 
Replace in the Edit menu. The Replace dialog opens (Figure 3-12). 

2 The drop-down in the Scan Source group box contains the text filters 
from previous searches. Select the filter you want to use, or enter a 
new filter.

For regular expressions and wildcards, click the right arrow button 
next to the drop-down to display a list of elements you can insert in 
the pattern. You can use Posix regular expressions and wildcard pat-
terns allowed in LIKE statements by Visual Basic for Applications 
(VBA).

Select the check boxes below the drop-down if you want the search 
to match case, skip comments, and/or match whole lines.

3 The drop-down in the Replace with group box contains the replace-
ment text filters from previous replace operations. Select the filter 
you want to use, or enter a new filter. Build the pattern for the re-
placement text the same way you built the pattern for matching text 
in step 2.

4 Click Replace. You are prompted to confirm the replacement. Click 
Yes.

Figure 3-12 Replace Dialog

filter on matching 
text

replacement text
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Object Information

The Object Information pane displays comments you have entered for 
an object. Select the object and choose Object Information in the View 
menu to show the Object Information pane (Figure 3-13). 

Enter comments for an object by right-clicking on the object and choos-
ing Properties in the pop-up menu. In the Description tab, enter your 
comment in the text area and click OK. For more information on object 
properties, see “Viewing Object Properties” on page 3-21.

Figure 3-13 Object Information Pane

Activity Log

The Activity Log is a chronological record of your activities in the cur-
rent session. Choose Activity Log in the View menu to show the Activ-
ity Log pane (Figure 3-14). 

By default, the Activity Log is docked. You can “float” the Activity Log 
pane by right-clicking the pane and deselecting Docked in the pop-up 
menu. 

Figure 3-14 Activity Log Pane

double-click to display list of errors
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Sorting Entries  Click a column heading in the Activity Log to sort the 
log by that column. 

Hiding Columns  Hide a column by right-clicking in the log and dese-
lecting the column name in the Columns choice on the pop-up menu.

Sizing Columns  Grab-and-drag the border of a column heading to in-
crease or decrease the width of the column. 

Viewing Errors  If the parser generated errors or warnings for a file, 
double-click the log entry for the file or right-click the entry and choose 
Expand in the pop-up menu to show a list of the errors and/or warnings. 

• A blue dot denotes successful parsing. 

• A red dot denotes an error. An error can have one of three severity 
levels: error, severe, critical, in order of increasing severity.

• A yellow dot denotes a warning.

Double-click a message to navigate to the offending source in the Editor. 
Choose Collapse in the right-click menu to collapse the list.

Generating Reports  You can generate a report from the Activity Log by 
right-clicking in the log and choosing Report in the pop-up menu. For 
more information on reports, see “Exporting Diagrams and Reports” on 
page 3-26.

Clearing the Log  You can clear the log by right-clicking in the log and 
choosing Clear Log in the pop-up menu. You can clear a given log entry 
by selecting the entry and choosing Delete in the right-click menu. 

Copying Records  To copy records to the clipboard, select the records 
and choose Copy in the right-click menu.

Viewing History  To view log entries across sessions, choose History
in the right-click menu. You can clear the history in the same way you 
cleared the log.
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Editor

The Editor lets you view and edit the source code for a file. It also lets 
you view the contents of specialized files like screens and transformation 
target models. Double-click a file in the Repository pane to view it in the 
Editor (Figure 3-15). Choose Recent Sources in the File menu to open 
a file from a list of recently opened files. 

Figure 3-15 Editor

Editing and Saving Source  You can edit file source as you would text 
in a word processor (cut-and-paste, drag-and-drop, and so forth). Click 
Save in the File menu to save your changes.Your edits are saved in the 
version of the file maintained in the \Workspace\Source subfolder (see 
“What File Outputs Can You Expect?” on page 3-4).

Tip: Tool tips show line numbers in the source file when you scroll 
the Editor vertically. 

Viewing a List of Errors  Choose Errors:View Errors in the Edit menu 
to list the errors and warnings generated for the file in a separate pane 
below the source code. Choose Errors:Severity Filter in the Edit menu 
to filter the list by severity. Deselect Errors:View Errors to hide the list. 

source code

errors and 
warnings

source code

double-click to find error in source

error in source
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To view only the list of errors and warnings for the file, select it and 
choose Show Errors in the right-click menu. 

Locating Errors  Double-click an error or warning in the error list or 
Activity Log to navigate to the offending source in the Editor. Choose 
Errors:Previous Error or Errors:Next Error in the Edit menu to nav-
igate to the previous and next errors, respectively, in the Editor.

Expanding Copybooks (Cobol, MFS Only)  Choose Expand Copy 
Statements in the Edit menu to expand included statements in the cur-
rent source. The added lines of code are highlighted and a comment line 
is inserted to identify the source include file. 

Commenting Out Source  Select a block of source and choose Com-
ment Block in the Edit menu to comment out the block. Choose Un-
comment Block to uncomment the block.

Changing Display Options  Choose User Preferences in the Tools 
menu and click the Editor tab in the User Preferences window to change 
the display characteristics for the Editor: 

• The font that source code is displayed in

• Whether color should be used in the source and, if so, the color of 
source elements (keywords, comments, and so forth)

• Whether to display DBCS escape control characters, as on a 3270 
terminal

Tip: Choose IBM 3270 Emulation in the Edit menu to toggle this 
selection on and off.

• The types of errors to include in the error list

The font and color functions use standard Windows controls. 

Printing Source  Click the Print choice in the File menu to print the 
source for a file.

Finding and Replacing Source  Choose Find or Replace in the Edit 
menu to use the Find and Replace utility. The utility provides full support 
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for Posix regular expressions. You can perform find and replace opera-
tions on the whole file or a selection. 

Restoring Line Numbers in Natural Source  Select a Natural source file 
and choose Restore Line Numbers in Natural Source in the Edit menu 
to restore stripped line numbers in the file. 

Creating a To Do List

A to do list is a record of tasks you need to perform before completing 
your project. You can create a to do list for a workspace, project, folder, 
source file, or extracted object.

To create a to do list:

1 In the Repository pane, select a workspace, project, folder, source 
file, or extracted object and choose ToDo List in the View menu. 
The ToDo List window opens (Figure 3-16). 

Figure 3-16 ToDo List Window

How the System Refreshes the Repository

When you edit a source file in ATW, the system recursively checks 
every repository object that may be affected by the edit — refreshes 
the repository. If the edit invalidates the object, you need to re-verify 
the source file that contains it. The file with the invalidated object is 
displayed in bold type in the Repository pane.
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2A If you selected a source file or extracted object in step 1 on page 
3-20, choose Add in the Edit menu to enter a task for the item. 

2B If you selected a workspace, project, or folder in step 1 on page 3-20, 
choose Add in the Edit menu to enter a task for the item and all the 
items it contains. Otherwise, choose Add for Item to enter a task for 
the workspace, project, or folder only. 

3 The New Properties dialog opens (Figure 3-17).

Figure 3-17 New Properties Dialog

4 In the Subject field, enter the subject of the task. In the Content 
field, enter a description of the task. Click OK. The task is listed in 
the ToDo List window.

To view a to do list:

1 To view the to do list for an item, select the item in the Repository 
pane and choose ToDo List in the View menu. Use the options in the 
ToDo List window Edit menu to mark a task as done, delete a task, 
or view its properties. 

Tip: You can generate a report from a to do list by choosing Re-
port in the File menu. For more information on reports, see 
“Exporting Diagrams and Reports” on page 3-26.
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Viewing Object Properties

Select an object in the Repository pane and choose Properties in the 
View menu to display a set of tabs with object properties (Figure 3-18). 

Figure 3-18 Object Properties Window

Entering Comments  Enter comments for an object in the Description 
tab. The object information pane displays the comments you have en-
tered for the selected object. For more information, see “Object Informa-
tion” on page 3-15.

Viewing Properties of Another Object  In the Relationships tab, select 
an object in the relationships tree and click Open to view the properties 
for that object. 

Closing and Resizing Panes

Close a pane by clicking the close box in the upper righthand corner of 
the pane. Reopen the pane by selecting the appropriate choice in the 
View menu. Resize a pane by using the mouse to grab its border with 
another pane, called a splitter, and dragging it to a new location.

enter comments 
for object



Asset Transformation Workbench Basics
Using Tool Windows

3-22
Using Tool Windows

When you open an ATW tool, its window replaces the workbench main 
window. Tool windows are modal — you cannot perform other work-
bench functions until you close the tool window. 

The tool window’s state — size, location, configuration, and content — 
is saved across sessions. Figure 3-19 shows the window for the Change 
Analyzer tool, which you use to perform impact analysis across applica-
tions.

Figure 3-19 Change Analyzer Window

Resizing Panes

Resize a pane by using the mouse to grab its border with another pane, 
called a splitter, and dragging the border to a new location. You can con-
trol how panes are resized when you resize the entire tool window by 

grab to show
virtual rectangle

drag virtual
rectangle to 
new position
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right-clicking the splitter and choosing one of the following in the pop-
up menu: 

• For a vertical splitter, Keep First preserves the size of the panes to 
the left of the splitter. For a horizontal splitter, Keep First preserves 
the size of the panes above the splitter.

• For a vertical splitter, Keep Second preserves the size of the panes 
to the right of the splitter. For a horizontal splitter, Keep Second pre-
serves the size of the panes below the splitter.

• Keep Proportion preserves the length and width ratio of the panes 
on either side of the splitter. 

Moving Panes 

Move a pane in the window by grabbing its title bar to show the “virtual 
rectangle” for the pane. The virtual rectangle is a dotted color frame that 
you can drag to the position in the window at which you want the pane 
to appear. When you are satisfied with the new position, release the 
mouse button. The other panes in the window are adjusted as necessary.

Tip: You may have to drag the virtual rectangle beyond the edge
of the tool window to achieve the effect you want.

You can swap the positions of the panes on either side of a splitter by 
right-clicking the splitter and choosing Swap in the pop-up menu. You 
can change the color of the splitter when it is selected (and of its virtual 
rectangle) by right-clicking the splitter and choosing Color in the pop-
up menu. The color functions use standard Windows controls.

Closing Panes

Close a pane by clicking the close box in the upper righthand corner of 
the pane. Reopen the pane by selecting the appropriate choice in the 
View menu.

When a Task Completes

If ATW does not have the focus on your desktop, its icon on the Win-
dows taskbar flashes briefly after it completes a task.
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Setting Options

ATW options control the look and feel of the workbench tools and how 
they perform their tasks. The Tools menu in the main workbench win-
dow gives you access to three sets of options:

• Workspace Options control the appearance and behavior of work-
bench tools for the current workspace.

• Project Options control the appearance and behavior of workbench 
tools for the selected project.

• User Preferences control the appearance and behavior of the Editor, 
HyperView, and Change Analyzer across workspaces, and miscella-
neous other tasks.

Each tool has an Options choice in the View menu that lets you set the 
options for that tool. 

Note: Many options are preset based on your choices in the ATW 
Configuration Manager. For more information, see “Config-
uring ATW” on page 2-9.

Workbench and tool options are described in detail in the relevant sec-
tions of the document set. This section shows you how to set options. As 
an example, it describes how you might change the way the workbench 
behaves at startup.

To set workbench startup options:

1 In the Tools menu in the ATW main window, choose User Prefer-
ences. The User Preferences window opens. Click the Environment 
tab (Figure 3-20 on page 3-25).

2 In the Environment tab, choose either:

• Prompt for workspace if you want the workbench to ask you 
which workspace to open at startup.

• Open most recent workspace if you want the workbench to 
open the last-opened workspace at startup.
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Figure 3-20 User Preferences Window

3 Deselect Show Registration dialog if you do not want the work-
bench to show a dialog prompting you to add files after creating a 
workspace (Figure 3-3 on page 3-3).

4 Choose one or more of the following:

• Assign files registered in workspace state to current project if 
you want the workbench to assign files to the current project after 
they have been registered.

• Verify registered files if you want the workbench to verify files 
after they have been registered. Available only if Assign files 
registered in Workspace state to current project is selected.

• Ask user about assignment and verification if you want the 
workbench to show a dialog prompting you to confirm that you 
want the workbench to assign and verify files after they have 
been registered (Figure 3-4 on page 3-4). Available whether or 
not the other two choices are selected.
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5 Choose either:

• Restricted to the current project if you want the object rela-
tionships shown in the Relationships tab of the Object Properties 
window (Figure 3-18 on page 3-21) to be limited only to those in 
the current project.

• Workspace wide if you want the relationships shown in the Re-
lationships tab of the Object Properties window to include all re-
lationships in the current workspace.

6A Click Apply if you want to save your settings without dismissing the 
User Preferences window. 

6B Click OK if you want to save your settings and dismiss the User 
Preferences window. The new settings take effect immediately.

Exporting Diagrams and Reports

Whenever you generate a diagram or report in ATW, you have the option 
of exporting it to a file for viewing, editing, or printing. You can export 
to a wide variety of standard formats.

Note: Word must be installed to save reports to RTF and Word. Ex-
cel must be installed to save reports to Excel and TXT. Visio 
2002 must be installed to save a diagram to Visio. Visio 2002 
is not required to save to Visio XML. 

Diagram and report generation is described in detail in the relevant sec-
tions of the document set. This section shows you how to export a report. 

Propagating Option Settings to Other Users

You can ensure uniform results across your team by propagating 
option settings to team members. Use the Save To choice in the drop-
down menu below the Tool Defaults push button to save your option 
settings to a file. You can then send the file to other users working on 
the same application. They use the Load From choice in the same 
menu to restore the option settings from the file. 
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As an example, it describes how you might export a reference report. Ex-
porting a diagram is similar.

To export a reference report:

1 In the File menu in the Reference Report window (not shown), 
choose Save Report As. The Save As dialog opens (Figure 3-21).

Figure 3-21 Save As Dialog

2 In the Save in drop-down, choose the folder to save the report file 
in. In the File name field, enter the name of the report file. Choose 
a name that describes the report as closely as possible. In the Save 
as type drop-down, choose the type of file you want to save the re-
port as. Click Save. The report file is created in the specified folder.

Specifying the Output Folder for Generated Files

By default, ATW stores generated files in the \Workspace\Output 
folder. You can specify a different folder in the Target directory field 
in the Export tab of the Project Options window (see “Setting Op-
tions” on page 3-24). Deselect the Move Files check box in the Ex-
port tab if you want to copy generated files to both the default and the 
specified directories.
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Using the Guide for a Tool

Many ATW tools have guides that you can use to get started quickly in 
the tool. The guides are help-like systems with hyperlinks that you can 
use to access functions otherwise available only in menus and other pro-
gram controls. 

To open the guide for a tool, choose Guide in the View menu. Use the 
table of contents in the Page drop-down to navigate quickly to a topic. 
Figure 3-22 on page 3-28 shows the guide for the Resource Retriever 
tool.

Figure 3-22 Resource Retriever Guide

What’s Next?

That completes your tour of ATW! Now you’re ready to start setting up 
ATW projects, as described in Preparing Projects in the workbench doc-
umentation set. 
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Installing and Using the 
WSAA Bridge
BM’s WebSphere Studio Asset Analyzer (WSAA) leverages 
the power of the WebSphere application server to offer modern 
enterprises easy-to-use Web-based tools for inventorying, analyz-

ing, and re-architecting application portfolios. The WSAA Bridge joins 
WSAA’s enterprise-wide scanning and analysis capabilities with the 
deep analysis available in ATW.

Understanding the WSAA Bridge

The WSAA Bridge distributes the source files in a WSAA project to PCs 
running ATW, and registers and verifies the source files in batch mode 
(Figure A-1 on page A-2). The bridge consists of a server component on 
a WebSphere application server (WAS), and client components running 
the application server client. Administrators use a Web interface to con-
figure the bridge, and to request file transfer, registration, and verifica-
tion, or import, services. 

When the administrator requests an import:

1 WSAA provides the bridge server with a list of files in the project.

I
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2 If the FTP option has been configured, the bridge server arranges 
for the files in the list to be downloaded from the mainframe via FTP. 
Otherwise, the bridge server compares the list of files with files man-
ually downloaded to a staging area for the project.

3 If the name of a downloaded file matches the name of a file in the 
WSAA list, the bridge server transfers the file to a DB/2 database.

4 The bridge server notifies bridge clients that WSAA project source 
files are available to be processed. 

5 Bridge clients retrieve source files and perform batch registration 
and verification, either locally or after distributing the files to PCs 
running the workbench.

Redundant mechanisms ensure that files are not processed unnecessari-
ly. Files downloaded to staging areas must be in ASCII format. 

Figure A-1 WSAA Bridge Import
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Hardware and Software Requirements

Table A-1 lists the hardware and software requirements for WSAA 
Bridge client installations. 

Table A-2 lists the hardware and software requirements for WSAA 
Bridge server installations. 

Contents of Installation CD

The WSAA Bridge client and server software ships on a single CD and 
uses the same installation program. The installation program is packaged 
in a platform-independent JAR file format and a Windows executable 
format. If you use the JAR file format, make sure that java.exe is in your 
path. The CD also contains ATW and ATW Profiler software.

Table A-1 Client Hardware and Software Requirements

Application Server Client WebSphere Application Server Cli-
ent 5.1, with Embedded Messaging 
Support

ATW ATW 1.1

Disk Space 30 MB

Table A-2 Server Hardware and Software Requirements

Application Server WebSphere Application Server 5.1, 
with Embedded Messaging Support

DBMS DB/2 Client or Server 7.2 with Fix 
Pack 12 WR21337, or DB/2 Client 
or Server 8.0. For DB/2 7.2, you 
must enable 7.2/XA Drivers. For 
assistance, contact support services.

Disk Space 6 MB
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Note: The CD autoruns the ATW installation program. Cancel the 
installation program if ATW is already installed, or does not 
need to be installed.

Running the Client Installation Program

Before running the client installation program, make sure you have ad-
ministrative permissions for the machine on which you are installing the 
client. If you do not have administrative permissions, the installation 
program will not let you continue. You can install multiple clients on the 
same machine.

To install the WSAA Bridge client:

1 Insert the CD into your CD-ROM drive. In the installation folder, 
double-click the setupwin32.exe program, or enter java -jar 
setup.jar in a command window. The Welcome screen opens 
(Figure A-2).

Figure A-2 Welcome Screen
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2 In the Welcome screen, click Next to continue. The License Agree-
ment screen opens. Read the License Agreement carefully. Click I 
accept the terms of the license agreement to accept its terms, then 
click Next to continue. The Destination Folder screen opens 
(Figure A-4).

Figure A-3 Destination Folder Screen

3 In the Destination Folder screen, choose an installation folder for 
the client. Figure A-3 shows the screen prefilled with the default 
C:\Program Files\IBM\WSAA Bridge. To accept the prefilled 
value, click Next.

To specify a different folder, click Browse. The Change Current 
Destination Folder screen opens (Figure A-4 on page A-6).
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Figure A-4 Change Current Destination Folder Screen

Navigate the folder structure to find a suitable location. Edit the 
name of the destination folder if necessary. Click Open to accept the 
specified location and return to the Destination Folder screen. Click 
Next in the Destination Folder screen to continue. The Feature to In-
stall screen opens (Figure A-5).

Figure A-5 Feature to Install Screen
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4 In the Feature to Install screen, place a check mark next to Client, 
then click Next to continue. The Application Server Client Informa-
tion screen opens (Figure A-6). 

Figure A-6 Application Server Client Information Screen

5 In the Application Server Client Information screen, enter the fol-
lowing information about the WebSphere application server client:

• In the Launch program path field, the path to the launch pro-
gram for the application server client. The field is prefilled with 
the current path of the launch program.

• In the Encoder program path field, the path to the password en-
coder program for the application server client. The field is pre-
filled with the current path of the password encoder program.

To specify a different path, click Browse, then follow the instruc-
tions in step 3 on page A-5. Click Next to continue.The Application 
Server Information screen opens (Figure A-7 on page A-8).
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Figure A-7 Application Server Information Screen

6 In the Application Server Information screen, enter the following 
information about the WebSphere application server that runs the 
WSAA bridge server:

• In the Server URL field, the URL of the application server. 
• In the Node name field, the node name of the application server. 

Note: The Server URL and Node name fields are disabled if you 
specified the launch program from the application server 
client installation in step 5 on page A-7, rather than the launch 
program from the application server installation.

• In the Server name field, the name of the application server.
• In the User identifier field, the name the client uses to connect 

to the application server.
• In the Password field, the password the client uses to connect to 

the application server.

Click Next to continue. The Client Information screen opens 
(Figure A-8 on page A-9).
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Figure A-8 Client Information Screen

7 In the Client Information screen, enter the following information 
about the bridge client:

• In the Client name field, the name of the client as it should 
appear in the administrative interface. By default, the name is 
formed by adding the suffix -bvclient to the machine name.

• In the Workbench path field, the path to the ATW installation. 
The field is prefilled with the current path of the ATW installa-
tion.

• In the Java path field, the path to the Java Virtual Machine 
(JVM) for the client installation. The field is prefilled with the 
current path of the JVM.

To specify a different path, click Browse, then follow the instruc-
tions in step 3 on page A-5. Click Next to continue. The Summary 
screen opens (Figure A-9 on page A-10).
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Figure A-9 Summary Screen

8 Click Install to begin transferring files to your machine. A progress 
meter indicates the progress of the transfer.

Note: To make changes to the settings, click Back repeatedly until 
you find the information you are looking for, make your 
changes, then click Next until you return to the Summary 
screen.

When the transfer is complete, the Setup Complete screen opens 
(Figure A-10 on page A-11). Click Finish in the Setup Complete screen 
to exit the installation. 
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Figure A-10 Setup Complete Screen

Running the Server Installation Program

Before running the server installation program, make sure you have ad-
ministrative permissions for the machine on which you are installing the 
server. If you do not have administrative permissions, the installation 
program will not let you continue.

Important: The Web Sphere Application Server must be running when you 
install the WSAA Bridge server.

To install the WSAA Bridge server:

1 Insert the CD into your CD-ROM drive. In the installation folder, 
double-click the setupwin32.exe program, or enter java -jar 
setup.jar in a command window. The Welcome screen opens 
(Figure A-2 on page A-4).

2 In the Welcome screen, click Next to continue. The License Agree-
ment screen opens. Read the License Agreement carefully. Click I 
accept the terms of the license agreement to accept its terms, then 
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click Next to continue. The Destination Folder screen opens 
(Figure A-3 on page A-5).

3 In the Destination Folder screen, choose an installation folder for the 
server. Figure A-3 on page A-5 shows the screen prefilled with the 
default C:\Program Files\IBM\WSAA Bridge. To accept the 
prefilled value, click Next.

To specify a different folder, click Browse, then follow the instruc-
tions in step 3 on page A-5. 

Click Next in the Destination Folder screen to continue. The Feature 
to Install screen opens (Figure A-5 on page A-6).

4 In the Feature to Install screen, place a check mark next to Server, 
then click Next to continue. The Application Server Information 
screen opens (Figure A-11).

Figure A-11 Application Server Information Screen
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5 In the Application Server Information screen, enter the following 
information about the WebSphere application server that runs this 
WSAA bridge server:

• In the Cell name field, the cell name of the application server.
• In the Node name field, the node name of the application server.
• In the Server name field, the name of the application server.

Click Next to continue. The DB/2 and Application Server Informa-
tion screen opens (Figure A-12).

Figure A-12 DB/2 and Application Server Connection Information Screen

6 In the DB/2 and Application Server Connection Information screen, 
enter the following connection information for the DB/2 and appli-
cation servers:

• In the DB/2 path field, the path to the DB/2 server. The field is 
prefilled with the current path of the DB/2 server.

• In the WebSphere Application Server path field, the path to 
the application server. The field is prefilled with the current path 
of the application server.
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• In the User identifier field, the name the bridge server uses to 
connect to the DB/2 and application servers.

• In the Password field, the password the bridge server uses to 
connect to the DB/2 and application servers.

Note: The installation assumes that the bridge server uses the same 
name and password for both servers.

To specify a different path, click Browse, then follow the instruc-
tions in step 3 on page A-5. Click Next to continue. A Summary 
screen similar to the one in Figure A-9 on page A-10 opens.

7 In the Summary screen, click Install to begin transferring files to 
your machine. A progress meter indicates the progress of the trans-
fer.

Note: To make changes to the settings, click Back repeatedly until 
you find the information you are looking for, make your 
changes, then click Next until you return to the Summary 
screen.

When the transfer is complete, the Setup Complete screen opens 
(Figure A-10 on page A-11). Click Finish in the Setup Complete screen 
to exit the installation. 

Starting the Client and Server

The bridge server and at least one client must be started before you can 
perform an import: 

• To start the server, click WSAA Bridge in the IBM program group 
in the Windows Start menu.

• To start the client, click Batch Verification Client (client name) in 
the IBM program group in the Windows Start menu, where client 
name is the name you specified in step 7 on page A-9. 
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Importing WSAA Projects

Administrators use a Web interface to configure the bridge and import 
WSAA project source files to an ATW workspace. 

Configuring WSAA Webservices

When you import a WSAA project, you specify the WSAA webservice 
that controls access to the project. Use the bridge administration inter-
face to configure webservices. You do not have to start WSAA clients to 
configure webservices. 

To configure WSAA webservices:

1 In Internet Explorer, go to http://host name:9080/rmw, where host 
name is the name of the machine running the bridge server. The 
WSAA Bridge Welcome screen opens. Click WSAA Configura-
tion. If you are configuring the bridge for the first time, the screen 
shown in Figure A-13 opens.

Note: If the bridge server is secured, you will be required to enter 
a user name and password to connect to the bridge server.

Figure A-13 WSAA Configuration Screen (Before Configuring Webservices)
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2 In the WSAA Configuration screen, enter the following information 
about each WSAA Webservice the bridge server accesses:

• In the Name field, the name of the webservice. 
• In the URL field, the URL of the webservice.
• In the User ID field, the name used to access the webservice.
• In the Password field, the password used to access the webser-

vice.

Note: The User ID and Password fields are for future use. You can 
enter any text, as long as you do not leave the fields blank.

When you are satisfied with your entries, click Add. A screen simi-
lar to the one shown in Figure A-14 opens.

Figure A-14 WSAA Configuration Screen (After Configuring Webservices)
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3 To edit WSAA webservice configuration information, click the edit 
link for the entry you want to modify. An edit dialog opens, where 
you can make the necessary changes. To delete a webservice entry, 
place a check mark next to the entry and click Delete Selected.

Requesting an Import

An import registers the source files in a WSAA project in an ATW work-
space and verifies the workspace in batch mode, either locally or after 
distributing the files to a PC running the workbench. You must start each 
bridge client you are using to import projects.

To import WSAA projects:

1 In the WSAA Configuration screen (Figure A-14 on page A-16), se-
lect the WSAA webservice for the import in the drop-down at the top 
of the window, then click Set Active.

2 Click Initiate Import. A screen similar to the one shown in 
Figure A-15 opens. The screen shows WSAA projects accessible to 
the active webservice and the destination folder and workspace you 
have specified for each project. 

Figure A-15 Initiate Import Screen
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3 Place a check mark next to the entry for each project you want to im-
port and click Import selected. A screen similar to the one shown in 
Figure A-16 opens. The screen shows the import information for 
each project you selected.

Figure A-16 Run Import Screen

4 To edit the import information for a project, click the edit link for 
the project. A screen similar to the one shown in Figure A-17 opens. 

Figure A-17 Edit Import Information Screen
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5 In the Edit Import Information screen, enter the following informa-
tion about the import request:

• In the Workspace Path field, the path of the folder for the work-
space that will contain the WSAA project. If the destination fold-
er does not exist, the bridge software creates it. Click the Browse 
button to open a standard Choose File window, where you can se-
lect the destination folder.

Tip: Source files can be distributed to any host visible to a client.

• In the Workspace field, the name of the workspace that will 
contain the WSAA project. If the workspace does not exist, 
the bridge software creates it. 

Tip: Remember that an ATW workspace can contain multiple 
projects.

• In the Project field, the name of the project in the workspace.

In the Sources Location area, select:

• FTP Server if you are downloading project source files via 
an FTP Server. Enter the URL of the FTP server and the ID and 
password for accessing the server in the appropriate fields.

• Staging Area if you have downloaded project source files man-
ually to a staging area. Enter the path of the staging area in the 
adjacent field. Click the Browse button to open a standard Choose 
File window, where you can select the staging area folder.

When you are satisfied with your choices, click Save. You are re-
turned to the Run Import screen (Figure A-16 on page A-18).

6 In the Batch Verification Queue drop-down, select the queue for 
each import request you have selected. There is one queue for each 
bridge client you have started. You can view queue information by 
clicking Queues Configuration in the administration interface.

7 Click Run Import to start the import request. Check the status of a 
request by clicking Check Import Actions in the administration in-
terface.
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Activity Log

The Activity Log is a chronological record of your activities in the 
current Asset Transformation Workbench (ATW) session.

ADABAS

ADABAS is a Software AG relational DBMS for large, mission-crit-
ical applications. 

Animator

Animator lets you step through the code displayed in a HyperView 
pane. You can choose program branches yourself, or have the anima-
tor choose them randomly.

API

API stands for application programming interface, a set of routines, 
protocols, and tools for building software applications.

applet

See Java applet.

Application Analyzer

Application Analyzer is a set of non-invasive interactive tools used to 
analyze and document legacy systems.
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Application Architect

Application Architect uses advanced algorithms to partition code into 
new components and perform Dead Code Elimination.

Application Namespace tool

The Application Namespace tool creates a conveniently organized 
dictionary that helps you navigate through your system’s terminology 
and modify it as necessary. 

Application Partitioner

Application Partitioner identifies legacy subsystems and partitions 
them into self-contained projects based on an analysis of repository 
contents.

Application Profiler

Application Profiler, consisting of WebGen and Profiler, generates a 
set of HTML views of a legacy application based on the object model 
created in a previous analysis.

AS/400

The AS/400 is a midrange server designed for small businesses and 
departments in large enterprises.

Asset Transformation Workbench (ATW)

Asset Transformation Workbench (ATW) is a suite of PC-based soft-
ware products for analyzing, re-architecting, and transforming legacy 
applications.

Batch Application Viewer

Batch Application Viewer performs low-level analysis of batch pro-
cesses.

batch refresh

The batch refresh feature lets you register and verify source files in 
batch mode. Other utilities packaged with the feature let you analyze 
application complexity, run WebGen, and, if you are licensed to use 
the Application Architect product, perform Dead Code Elimination. 

Bird’s Eye pane

The Bird’s Eye pane works with the HyperView Source pane to let 
you quickly identify the location of a code construct relative to the 
entire program.
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BMS

BMS stands for Basic Mapping Support, an interface between appli-
cation formats and CICS that formats input and output display data.

BSTR

BSTR is a Microsoft format for transferring binary strings.

business rule

A business rule is a named container that identifies and documents 
code segments according to their business function. Business rules en-
capsulate an application’s business logic, making the application eas-
ier to understand, document, maintain, and test.

Business Rule Manager

Business Rule Manager lets you generate business rules from code 
segments extracted manually from source or autodetected. 

Callie pane

The HyperView Callie pane displays a diagram that shows the flow of 
control between paragraphs or procedures in a program.

CDML

CDML stands for Cobol Data Manipulation Language, an extension 
of the Cobol programming language that enables applications pro-
grammers to code special instructions to manipulate data in a DMS 
database and to compile those instructions for execution. 

Change Analyzer

Change Analyzer identifies the class of data items used to perform a 
business function in a legacy application. Among other uses, it lets 
you answer the kinds of “What if?” questions posed in the recent past 
by the industry-wide changes for Y2K, Zip+4, and the Euro dollar: 
“What if I change the type of this variable, or the length of this field 
— what other fields will I also have to change?”

CICS

CICS stands for Customer Information Control System, a program 
that allows concurrent processing of transactions from multiple termi-
nals.
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Clipper

The HyperView Clipper tool lets you create lists of candidates for 
business rule extraction, event injection, and other tasks. Each list 
captures the results of a different stage of your analysis and serves as 
input for subsequent tasks.

Cobol

Cobol stands for Common Business-Oriented Language, a high-level 
programming language used for business applications.

COM

COM stands for Component Object Model, a software architecture 
developed by Microsoft to build component-based applications. COM 
objects are discrete components, each with a unique identity, which 
expose interfaces that allow applications and other components to ac-
cess their features.

complexity

A project’s complexity is an estimate of how difficult it is to maintain, 
analyze, transform, and so forth.

component

A component is a self-contained program that can be reused with 
other programs in modular fashion. 

Component Maker

The HyperView Component Maker tool lets you “slice out” compo-
nents from legacy applications — not only component executables but 
associated Cobol copybooks, PL/I includes, and Natural data areas as 
well.

computation-based component extraction

Computation-based component extraction lets you build a component 
that contains all the code necessary to calculate the value of a variable 
at a particular point in a program — the value of a DayOfTheWeek 
variable, for example, where it is used to populate a report attribute or 
screen.

Configuration Manager

Configuration Manager is a tool used to enable Asset Transformation 
Workbench (ATW) products and configure your workbench for the 
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tools, programming languages, legacy dialects, and character sets in 
use at your site.

construct

A construct is an item in the parse tree for a source file — a section, 
statement, condition, variable, or the like. A variable, for example, can 
be related in the parse tree to any of three other constructs — a decla-
ration, a dataport, or a condition. You view the parse tree for a source 
file in the HyperView Context pane.

Context pane

The HyperView Context pane displays the parse tree for the selected 
source file. The parse tree displays source code constructs — sections, 
paragraphs, statements, conditions, variables and so forth — in hier-
archical form, making it easy to locate code constructs quickly.

copybook

A copybook is a common piece of source code to be copied into many 
Cobol source programs. Copybooks are functionally equivalent to C 
and C++ include files.

CORBA

CORBA stands for Common Object Request Broker Architecture, an 
architecture that enables distributed objects to communicate with one 
another regardless of the programming language they were written in 
or the operating system they are running on.

CSD file

CSD stands for CICS System Definition. A CSD file is a VSAM data 
set containing a resource definition record for every resource defined 
to CICS.

database schema

A database schema is the structure of a database system, described in 
a formal language supported by the DBMS. In a relational database, 
the schema defines the tables, the fields in each table, and the relation-
ships between fields and tables.

dataport

A dataport is an input/output statement or a call to or from another 
program.
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DB/2

DB/2 stands for Database 2, an IBM system for managing relational 
databases.

DBCS

DBCS stands for double-byte character string, a character set that uses 
two-byte (16-bit) characters rather than one-byte (8-bit) characters.

DBMS

DBMS stands for database management system, a collection of pro-
grams that enable you to store, modify, and extract information from 
a database.

DDL

DDL stands for Data Description Language (DDL), a language that 
describes the structure of data in a database.

Dead Code Elimination

Dead code elimination is a type of component extraction that removes 
unused (“dead”) code from a legacy application.

decision resolution

Decision resolution lets you identify and resolve dynamic calls and 
other relationships that the parser cannot resolve from static sources.

Diagrammer

Diagrammer lets you view the relationships between the objects in a 
project interactively — programs, files, DDL, Java, screen maps, and 
more. These relationships describe the ways in which application 
objects interact. Compare Quick Diagrammer.

DMS

DMS stands for Data Management System, a Unisys database man-
agement software product that conforms to the CODASYL (network) 
data model and enables data definition, manipulation, and mainte-
nance in mass storage database files.

domain-based component extraction

Domain-based component extraction “specializes” a program based 
on the values of one or more variables. The specialized program is 
typically intended for reuse “in place” — in the original application 
but under new external circumstances.
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DPS

DPS stands for Display Processing System, a Unisys product that 
enables users to define forms on a terminal.

ECL

ECL stands for Executive Control Language, the operating system 
language for Unisys OS 2200 systems.

effort

Effort is an estimate of the time it will take to complete a task related 
to a project, based on weighted values for selected complexity met-
rics.

EJB

EJB stands for Enterprise JavaBeans, a Java API developed by Sun 
Microsystems that defines a component architecture for multi-tier 
client/server systems. 

EMF

EMF stands for Enhanced MetaFile, a Windows format for graphic 
images.

entity

An entity is an object in the repository model for a legacy application. 
The relationships between entities describe the ways in which the el-
ements of the application interact.

entry point isolation

Entry point isolation extracts a component that contains only the func-
tionality and data definitions required for invocation from the selected 
entry point. 

event injection

Event injection is a type of component extraction that adapts a legacy 
program to asynchronous, event-based programming models. 

Execution Path pane 

The HyperView Execution Path pane displays a hierarchical view and 
diagram of the conditions that determine the flow of control in a pro-
gram.
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external subroutine extraction

External subroutine extraction is a type of structure-based component 
extraction that replaces a single internal subroutine in a Natural pro-
gram with an external subroutine.

FCT

FCT stands for File Control Table (FCT), a CICS table that contains 
processing requirements for output data streams received via a remote 
job entry session from a host system. Compare PCT.

Flowchart pane

The HyperView Flowchart pane displays a diagram of the flow of 
control between statements in a paragraph or procedure.

Global Data Flow tool

The HyperView Global Data Flow tool performs low-level analysis of 
program data flows. 

HTML

HTML stands for HyperText Markup Language, the authoring lan-
guage used to create documents on the World Wide Web.

HyperView

HyperView is a set of program analysis tools that let you analyze leg-
acy programs interactively, by examining synchronized, complemen-
tary views of the same information — source, context, impacts, and so 
forth. 

IDL

IDL stands for Interface Definition Language (IDL), a generic term 
for a language that lets a program or object written in one language 
communicate with another program written in an unknown language.

IDMS

IDMS stands for Integrated Database Management System, a Com-
puter Associates database management system for the IBM main-
frame and compatible environments. 

Impact pane

The HyperView Impact pane displays a hierarchical view and dia-
gram of the impact trace for a program variable. An impact trace de-
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scribes how data items interact with each other in a program — 
exchange values, use each other in computations, and so forth.

Impact Report pane

The HyperView Impact Report pane shows the flow of data from a 
startup item to every data item that would be affected by its modifica-
tion. The report is organized in hierarchical form according to the 
depth of the affected item.

IMS

IMS stands for Information Management System, an IBM program 
product that provides transaction management and database manage-
ment functions for large commercial application systems.

Java

Java is a high-level object-oriented programming language developed 
by Sun Microsystems.

Java applet

A Java applet is a program that can be sent with a Web page. Java ap-
plets perform interactive animations, immediate calculations, and oth-
er simple tasks without having to send a user request back to the 
server.

JavaBeans

JavaBeans is a specification developed by Sun Microsystems that de-
fines how Java objects interact. An object that conforms to this spec-
ification is called a JavaBean. 

JCL

JCL stands for Job Control Language, a language for identifying a job 
to OS/390 and for describing the job’s requirements.

JDBC

JDBC stands for Java Database Connectivity, a standard for accessing 
diverse database systems using the Java programming language. 

job

A job is the unit of work that a computer operator or a program called 
a job scheduler gives to the operating system. In IBM mainframe op-
erating systems, a job is described with job control language (JCL).
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job dependencies

Batch Application Viewer treats jobs as dependent if one writes to a 
dataset and the other reads from the same dataset. Occasionally, you 
may want to define dependencies between jobs based on other criteria 
— administrative needs such as scheduling, for example.

logical component

A logical component is an abstract repository object that gives you ac-
cess to the source files that comprise a component.

MFS

MFS stands for Message Format Service, a method of processing IMS 
input and output messages.

Missing Copybooks Resolution tool

The Missing Copybooks Resolution tool resolves undefined variables 
in missing copybooks for Cobol programs verified with the relaxed 
parsing option.

Model Reference pane 

The HyperView Model Reference pane displays the parse tree meta-
model in text and diagram form. 

name-based partitioning

Name-based partitioning is a partitioning algorithm that assigns 
source files to projects based on text matching of source file names 
with specified patterns.

Natural

Natural is a programming language developed and marketed by Soft-
ware AG for the enterprise environment.

object model

An object model is a representation of an application and its encapsu-
lated data.

object-oriented programming

Object-oriented programming organizes programs in terms of objects 
rather than actions, and data rather than logic.
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ODBC

ODBC stands for Open Database Connectivity, a standard for access-
ing diverse database systems.

orphan

An orphan is an object that does not exist in the reference tree for any 
startup object. Orphans can be removed from a system without alter-
ing its behavior.

Orphan Analysis tool

The Orphan Analysis tool lets you analyze and resolve orphans.

parser

The Asset Transformation Workbench (ATW) parser defines the ob-
ject model and parse tree for a legacy application.

parse tree

A parse tree defines the relationships among the constructs that com-
prise a source file — its sections, paragraphs, statements, conditions, 
variables, and so forth. 

PCT

PCT stands for Program Control Table, a CICS table that defines the 
transactions that the CICS system can process. Compare FCT.

PL/I

PL/I stands for Programming Language One, a third-generation pro-
gramming language developed in the early 1960s as an alternative to 
assembler language, Cobol, and FORTRAN.

PL/I Call Diagrammer

PL/I Call Diagrammer performs low-level analysis of PL/I programs. 
Use it to examine call flows for internal procedures that the 
Diagrammer is unable to model.

profile

Profiles are HTML views into a repository that show all of the analy-
sis you have done on an application. Profiles are convenient ways to 
share information about legacy applications across your organization.
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Profiler

Profiler is a Web server-based tool that offers company-wide access 
to profiles of any repository in your organization. It gives managers, 
business analysts, testers, and customer support personnel convenient, 
browser-based access to analyzed legacy code.

project

A project is a logical subdivision of a workspace. You might have a 
project for the batch portion of your application and another project 
for the online portion, for example. You can also use a project to col-
lect items for discrete tasks — all the source files affected by a change 
request, for example.

QSAM

QSAM stands for Queued Sequential Access Method, a type of 
processing that uses a queue of data records—either input records 
awaiting processing or output records that have been processed and 
are ready for transfer to storage or an output device.

Quick Diagrammer

The Quick Diagrammer tool lets you view relationships for selected 
objects only, rather than an entire project. Compare Diagrammer.

refactoring

Refactoring translates a program into a component with the same 
functionality and control flow, but a simpler syntax structure.

reference reports

Asset Transformation Workbench (ATW) offers three related reports 
that you can use to identify missing or unneeded program elements in 
application source: an unresolved report, an unreferred report, and a 
cross-reference report.

relationship

The relationships between entities in the repository model for a legacy 
application describe the ways in which the elements of the application 
interact. 

relationship-based partitioning

Relationship-based partitioning is a partitioning algorithm that as-
signs source files to projects based on the extent to which the source 
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files are related. If two source files reference the same copybook, for 
example, they can be regarded as “tightly related,” at least as com-
pared with source files that do not reference the same copybook.

relationship weight

A relationship weight determines the importance of that relationship 
in calculating the connection between source files in relationship-
based partitioning.

relaxed parsing

Relaxed parsing lets you verify a source file despite errors. Ordinarily, 
the parser stops at a statement when it encounters an error. Relaxed 
parsing tells the parser to continue to the next statement.

repository

A repository is a database of program objects that comprise the model 
for a workspace.

Repository Browser

The Asset Transformation Workbench (ATW) Repository Browser 
displays the contents of the current workspace.

Resource Retriever

The Resource Retriever tool lets you identify and restore missing 
CICS file connectors and transactions in file control tables (FCT) and 
program control tables (PCT) for Cobol and PL/I programs.

Rules pane 

The HyperView Rules pane lets you create business rules from code 
segments extracted manually from source or autodetected. You can 
also create business rules from candidates listed in Clipper.

schema

See database schema.

scope

The scope of a diagram determines the objects and relationships it dis-
plays. See Diagrammer.

seed field

A seed field is the object of a Change Analyzer search for the class of 
data items that need to be changed.
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Source pane 

The HyperView Source pane displays view-only source code for the 
selected file and included files. 

SQL

SQL stands for Structured Query Language, a standard language for 
relational database operations

structure-based component extraction

Structure-based component extraction is a type of component extrac-
tion that builds a component from a range of inline code — Cobol 
paragraphs, for example. 

synonym

A synonym is a data field whose value is related to the value of the 
matched seed field — a field whose value is assigned by a MOVE or 
REDEFINE statement, for example.

system program

A system program is a generic program — a mainframe sort utility, for 
example — provided by the underlying system and used in unmodi-
fied form in the legacy application.

TIP

TIP stands for Transaction Processing, the Unisys real-time system 
for processing transactions under Exec control.

token

In the Application Namespace tool, a token is an element in a program 
identifier delimited by a hyphen (-) or underscore (_). In the identifier 
WS01-CUST-FIELD, for example, there are three tokens: WS01, 
CUST, and FIELD.

transaction

A transaction is a sequence of information exchange and related work 
(such as database updating) that is treated as a unit for the purposes of 
satisfying a request and for ensuring database integrity.

Unknown Statements Resolution tool

The Unknown Statements Resolution tool resolves incorrect or unsup-
ported statements in Cobol programs verified with the relaxed parsing 
option.
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User Interface tool

The User Interface tool lets you analyze the interaction between lega-
cy screens and program logic, and generate an HTML or Java GUI 
based on the interaction.

VALTAB

VALTAB stands for Validation Table, which contains the information 
the system needs to locate, load, and execute transaction programs. 
See also TIP.

VSAM

VSAM stands for Virtual Storage Access Method, an IBM program 
that controls communication and the flow of data in a Systems Net-
work Architecture network.

WebGen

WebGen generates HTML views of the repositories on your worksta-
tion. You can publish the views to Profiler, where they can be 
accessed by any member of your organization with a browser. 

workspace

A workspace is a named container for an application or a portion of an 
application. Workspaces can be divided into projects.

XML

XML stands for Extensible Markup Language, a specification for cre-
ating common information formats. 



GlossaryGL-16



Bibliography
• IBM Asset Transformation Workbench v1.1 Getting Started (SC31-6877-00)

• IBM Asset Transformation Workbench v1.1 Preparing Projects (SC31-6879-00)

• IBM Asset Transformation Workbench v1.1 Analyzing Projects (SC31-6880-00)

• IBM Asset Transformation Workbench v1.1 Analyzing Programs (SC31-6878-00)

• IBM Asset Transformation Workbench v1.1 Profiling Projects (SC31-6881-00)

• IBM Asset Transformation Workbench v1.1 Creating Components (SC31-6876-00)

• IBM Asset Transformation Workbench v1.1 Parser Reference (SC31-6882-00)

• IBM Asset Transformation Workbench v1.1 Architecture Reference (SC31-6898-00)
© Copyright IBM Corp.  2004  1



 

 2 IBM Asset Transformation Workbench v1.1: Getting Started  



Notices
This information was developed for products and services offered in the U.S.A. IBM® may not 
offer the products, services, or features discussed in this document in other countries. Consult 
your local IBM representative for information on the products and services currently available 
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equivalent product, program, or service that does not infringe any IBM intellectual property 
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operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this 
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Armonk, NY 10504-1785

U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual 
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Tokyo 106, Japan
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THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR 
FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express 
or implied warranties in certain transactions, therefore, this statement may not apply to you. 
This information could include technical inaccuracies or typographical errors. Changes are 
periodically made to the information herein; these changes will be incorporated in new editions 
of the publication. IBM may make improvements and/or changes in the product(s) and/or the 
program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only 
and do not in any manner serve as an endorsement of those Web sites. The materials at those 
Web sites are not part of the materials for this IBM product and use of those Web sites is at 
your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate 
without incurring any obligation to you.  Licensees of this program who wish to have 
information about it for the purpose of enabling: (i) the exchange of information between 
independently created programs and other programs (including this one) and (ii) the mutual 
use of the information which has been exchanged, should contact:
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IBM Corporation

P.O. Box 12195, Dept. TL3B/B503/B313

3039 Cornwallis Rd.

Research Triangle Park, NC 27709-2195

U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in 
some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are 
provided by IBM under terms of the IBM Customer Agreement, IBM International Program 
License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. 
Therefore, the results obtained in other operating environments may vary significantly. Some 
measurements may have been made on development-level systems and there is no guarantee 
that these measurements will be the same on generally available systems. Furthermore, some 
measurement may have been estimated through extrapolation. Actual results may vary. Users 
of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, 
their published announcements or other publicly available sources. IBM has not tested those 
products and cannot confirm the accuracy of performance, compatibility or any other claims 
related to non-IBM products. Questions on the capabilities of non-IBM products should be 
addressed to the suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal 
without notice, and represent goals and objectives only. This information contains examples of 
data and reports used in daily business operations. To illustrate them as completely as possible, 
the examples include the names of individuals, companies, brands, and products. All of these 
names are fictitious and any similarity to the names and addresses used by an actual business 
enterprise is entirely coincidental.
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Trademarks

The following terms are trademarks of the IBM Corporation or its subsidiaries in the United 
States or other countries or both:

   

 

The following terms are trademarks of other companies:

Java and JavaScript are registered trademarks and Sun Solaris and Solaris are trademarks of 
Sun Microsystems, Inc. in the United States, other countries, or both.

Microsoft and Windows are trademarks of Microsoft Corporation in the United States, other 
countries, or both.

Other company, product and service names may be trademarks or service marks of others.

Table 1. Trademarks
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AS400 CICS

IMS DB/2
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 S/390 z/OS
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